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Congratulations on your purchase of the Orion StarShoot 
Planetary Imager & AutoGuider (SSPIAG)! Your SSPIAG 
can be used as a planetary imager or autoguider, making 
it a useful imaging accessory for virtually any telescope 
setup.

You will be able to capture detailed views of the planets 
and other objects in the Solar System, or you can use the 
camera to precisely track the apparent movement of the 
night sky without the need for you to monitor your tele-
scope setup every second. When autoguiding, the track-
ing corrections made by the SSPIAG will compensate for 
mechanical imperfections inherent in all telescope mounts. 
This essential astro-imaging tool allows you to relax under 
the stars while your telescope tracks and takes images.

Parts list
• StarShoot Planetary Imager & AutoGuider

• 10' USB Cable

• 6' autoguide interface cable

• CD-ROM

System requirements

computer
The SSPIAG requires a PC running Windows XP or Vista. For astro-imaging in 
the field at night, a laptop computer is highly recommended.

The computer hardware should have at least the following:

• Pentium™ Processor

• 128MB RAM

• Disk Space – 1GB or more is recommended

• Video Display – 1024 X 768, 16-bit color or higher

• Mouse

• USB High Speed 2.0 port
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to use as a Planetary Imager
Just about any telescope is suitable for the SSPAIG when imaging the planets. 
The longer the focal length of the telescope, the larger and more detailed the 
images will appear. Unlike deep space astro-imaging, you actually want to have a 
long focal length and focal ratio for planetary imaging. Adding a 2x, 3x, or higher 
barlow to the telescope is not uncommon for planetary imaging. The planets and 
other solar system objects are relatively bright and can be imaged with a darker, 
or “slower” focal ratio.

We recommend a telescope mounted on a motorized altitude-azimuth or German 
Equatorial mount. You can potentially capture the Moon or a planetary image with 
a telescope that does not track, however you may not get optimum results. The 
sky moves 15 arcseconds per second! If you are imaging through a long focal 
length telescope, you essentially need to track the object or unwanted blurring 
could occur.

to use as an Autoguider
The SSPIAG is also a fully functional autoguider. The autoguider output is on-
board the camera, allowing the autoguider cable to connect directly from the 
camera to your mount’s autoguider port.

Primary Telescope/Main Imaging Scope
Your main imaging scope will be used with your main astro-imaging camera. The 
main imaging scope can be virtually any scope suitable for your CCD or DSLR 
camera.

Figure 1a. A traditional imaging setup contains a main imaging scope and separate 
guide scope. The SSPIAG interfaces with your computer via the USB cable, and 
connects to your mount’s autoguide port via the autoguide cable.
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AutoGuide Cable
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XP or Vista 

Guide Scope 
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AutoGuider 
Port 
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SSPIAG
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Imaging Cam

Figure 1b. Cassegrain style telescopes can be used with an off-axis guider. This 
allows both the main imaging camera and autoguider to use the same telescope.
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Figure 2. Adjustable guide scope tube rings allow you to adjust the position of the 
guide scope without moving the main imaging scope.

Adjustable guide scope tube rings
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Mount
An equatorial mount with dual axis motors and a RJ-12 autoguide port is required. 
Just about any equatorial mount equipped with an autoguide port will work with 
the SSPIAG (Figure 3a). The SSPIAG is “ST-4” compatible which uses the same 
pin out configuration as the first generation CCD autoguiders (Figure 3b). Most 
computerized goto mounts also have this autoguide port. For short exposure 
deep space photography (typically 45 seconds or less) the SSPIAG can suc-
cessfully guide with a computerized altitude-azimuth or fork mounted telescope, 
popular among computerized Schmidt-Cassegrain telescopes. However, guided 
exposures longer than one minute in an altitude-azimuth mount will cause field 
rotation to occur in the image (Figure 4). An equatorial mount will yield the best 
overall performance for guided deep space astrophotography.

Software and Driver Installation
Before the camera can be used, software and camera drivers must be installed 
onto your computer. Turn on your computer and allow the Windows operating 
system to load as normal. Insert the included CD-ROM into your computer’s 
CD-ROM drive, and the Launcher will appear (Figure 5). This allows you to install 
the PHD Planetary and PHD Guiding software. Do not connect the camera to 
your computer before you have installed the software.

Guide Scope
You will need an additional telescope for guiding, referred to as a guide scope. The 
guide scope is mounted on top of, or beside the main imaging scope. Adjustable 
guide scope tube rings (available from Orion) are recommended and allow you 
to move the guide scope around without moving the main imaging scope (Figure 
2). The guide scope is adjusted in the same fashion as a finder scope.

Because of the high resolution and accuracy of the SSPIAG, you do not need a 
large guide scope; any small refractor will serve well for this purpose. Separate 
refractor optical tube assemblies, such as the Orion Short Tube 80, make excel-
lent guide scopes.

The only exception to using a guide scope is to is use an off-axis guider, which 
is typically made for Schmidt-Cassegrain telescopes (Figure 1b). The off-axis 
guider uses a prism to intercept a small portion of the light path in front of the 
camera, thus allowing the camera and guider to use the same telescope. Off-axis 
guiders require a large amount of inward focus travel which is why they are only 
suitable for Cassegrain type telescopes.

Figure 4. Field Rotation occurs in long 
exposure images taken with an altitude-
azimuth mount or poorly polar aligned 
equatorial mount.

Figure 3a. The SSPIAG works with 
any mount equipped with an ST-4 
compatible autoguide port, shown here on 
the Sirius EQ-G mount.

Figure 3b. This is the pin diagram for 
the SSPIAG and ST-4 compatible mounts.

Auto guider port

Figure 5. The launcher offers an easy way to start installing the camera and software.
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Software Installation
1. Insert the CD-ROM and wait for the Launcher window to appear. If you are 

using Windows Vista, the AutoPlay window will appear first, then select 
Run Opener.exe.

2. When the launcher appears, select Install PHDGuide.

3. Read the license agreement and select I accept the agreement if you 
agree with the terms. Follow the prompts to complete the software instal-
lation.

4, Next, select Install PHDPlanetary and follow the same steps to complete 
installation.

Installing the camera using a Windows XP computer:
1. Insert the CD-ROM and wait for the launcher window to appear.

2. When the launcher appears, select Install Drivers. Do not plug the camera 
in before loading the drivers.

3. Once the drivers have been installed, connect the SSPIAG to your com-
puter’s USB port.

Figure 6. In Windows XP the Found New Hardware Wizard appears when you first 
plug the SSPIAG into your USB port.

4. In Windows XP a Found New Hardware Wizard appears (Figure 6).

5. Windows will ask if you want to search for drivers and updates online. 
Select No, not this time and click Next.

6. Next, choose Install the software automatically.

7. Windows will note that the driver has not passed Windows Logo testing. 
This is normal. Click the Continue Anyway button. When the Wizard has 
completed, click the Finish button.

8. You will immediately be prompted with a Found New Hardware Wizard 
again. This time the camera firmware will be installed. Make the same 
selections again in the Wizard, No, not this time, click Next, and choose 
Install the software automatically. The camera is now installed on your 

computer and the red LED on the camera should be on.

Installing the camera using a Windows Vista computer:
1. Insert the CD-ROM and wait for the AutoPlay window to appear. Load Run 

Opener.exe. (Figure 7)

2. Select Install Drivers. Follow the prompts in the install screen to complete 
the driver installation.

3. Windows will note that the driver has not passed Windows Logo testing. 
This is normal. Click the Continue Anyway button. When the Wizard has 
completed, click the Finish button.

4. Once the drivers have been installed, connect the SSPIAG to your com-
puter’s USB port.

5. Windows Vista will automatically detect the camera and install the device 
for you. Wait for the dialog box in the taskbar to say Device Installed 
Successfully. The camera is now installed on your computer and the red 
LED on the camera should be on.

Figure 7. In Windows Vista the 
AutoPlay screen appears when you 
insert the CD-ROM into your computer. 
Select Run Opener.exe when prompted 
with this screen.
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Getting Started During the Day
We recommend using the SSPIAG for the first time during the day. This way, you 
can become familiar with the basic camera functions without having to stumble 
around in the dark.

First, let’s explore the interface of the two included software programs that oper-
ate your SSPIAG, PHD Planetary and PHD Guiding.

A. Auto Exp and Exposure Control Slider: Check 
the Auto exp box for most uses. To manually adjust 
the exposure, uncheck the box and drag the slider 
to the right or left to increase or decrease the expo-
sure.

B. Auto Gain and Gain Control Slider: Check the 
Auto gain box for most uses. To manually adjust the 
gain, uncheck the box and drag the slider to the right 
or left to increase or decrease the gain. Note that 
higher gains will show more noise.

C. Long Exposure: Checking this box enables you 
to increase the exposure control slider to 5000ms (5 

PHD Planetary

seconds). This setting is useful if you are trying to 
capture an especially faint object or if you’re using a 
very long focal ratio. Note that the noise will increase 
dramatically after 2-3000ms. Also note that the pro-
gram will not respond to other commands during 
long exposures.

D. High Gain: Check this box to boost the gain level 
and increase the sensitivity at the expense of extra 
noise.

E. Companding: Checking this box can increase 
the dynamic range in faint objects by compressing 
the image intensity scale.

F. High Dynamic: Checking this box can increase 
the dynamic range in bright objects, also by com-
pressing the image intensity scale.

G. Reduce Noise: Check this box to enable a noise 
reduction scheme that helps reduce horizontal line 
noise in the images.

H. Local Raw Preview: Provides a live display of 
the raw image from the camera. Click on this window 
to toggle through the different views offered: Local 
RAW Histogram, Full Histogram, Local Zoomed 
Preview, and 2D FFT (for focusing).

I. Stop Preview: Stops streaming images from the 
camera.

J. Capture/Stop Capture: Captures and saves 
RAW images to your hard disk. While capturing, the 
same button will enable you to stop the capture.

K. Still Cap: Captures and saves a single expo-
sure.

L. Preset how many frames you wish to capture. 
Leave at 0 for an unlimited number of frames.

M. File Name and Save Path: Choose the name 
of the capture sequence and specify the folder you 
want to save it on.
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using the camera for the First time
1. Setup your telescope and use an eyepiece to locate an object outside that 

is 200 yards or more away.

2. Plug the SSPIAG into your computer’s USB port.

3. Remove the eyepiece and insert the SSPIAG into the 1.25” eyepiece holder 
on your telescope.

4. Open PHD Planetary and in the Camera menu, select the Orion SSPIAG 
(Figure 8). The camera will connect and automatically begin previewing the 
images at a high frame rate (Figure 9).

5. If the image looks too bright or overexposed, manually lower the Gain (%) 
to 5%. If necessary, lower the Exposure slider bar as well.

6. Gradually move the telescope focus inward until you get a sharp image 
on your computer screen (Figure 10). The SSPIAG focuses approximately 
15mm inward from a standard 1.25” eyepiece. On most refractors, a 1.25” 
extension tube (available from Orion) is usually needed to reach focus. 
Alternatively, you can use a star diagonal. Note the approximate position 
of your focuser where the SSPIAG reached focus on your guidescope to 
make the same task at night much easier.

7. Experiment with the different camera processing options such as High 
Gain, or Noise Reduction, to become familiar with how the images 
respond.

A. Connect to Camera: Selects and connects to the autoguider cam-
era. Choose the StarShoot AutoGuider or the older StarShoot DSCI 
camera.

B. Connect to Telescope: This command connects the SSAG to your 
mount. To connect the SSAG to your mount, go to the Mount menu 
and select On-camera, then click this icon.

C. Looping Exposures: Takes continuous exposures for acquiring 
and focusing the guide star.

D. PHD Guide: Automatically calibrates and guides. Once your guide 
star is found and focused, simply click on the star and click PHD 
Guide. The rest is automatic!

E. Stop: Stops either calibrating, guiding, or looping exposures.

F. Exposure Selection: Choose from 14 different exposure times for 
the camera.

PHD Guiding G. Guide Star Box: When a guide star is selected, a green box 
appears around it. PHD Guiding will display the pixel coordinates of the 
star in the lower left screen. When the calibration routine starts, yellow 
crosshairs are displayed around the box. When the autoguiding begins, 
the crosshairs turn green. This box does not appear until a guide star 
has been selected. (See “Start Autoguiding”)

H. Gamma Adjustment: Adjust the apparent screen brightness level in 
the image by moving the slider bar left (brighter) or right (fainter).

I. Advanced Parameters: Control the camera and guiding routine set-
tings. You do not typically have to adjust the advanced parameters. For 
very bright guide stars, or for daytime testing, the camera gain can be 
adjusted in this menu. (See “Advanced Autoguider Settings” for more 
detail about this menu.)

J. Take Dark Frame: Captures and internally saves a dark frame that is 
automatically subtracted from future exposures. Taking a dark frame is 
optional and not required for normal use. See “Dark Frames and Noise 
Reduction” for more information.
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Planetary Imaging
Planetary imaging is also referred to as Solar System imaging, and includes the 
Moon, the Sun (with a proper full aperture solar filter!), the planets, and miscella-
neous objects in Earth’s orbit such as the International Space Station (ISS). The 
SSPIAG is capable of capturing all these objects in real time.

Preview
To begin previewing images to focus and later capture, follow this simple proce-
dure:

1. Plug the SSPIAG into your computer’s USB port.

2. Insert the SSPIAG into the 1.25” eyepiece holder on your telescope.

3. Open PHD Planetary and in the Camera menu, select the Orion SSPIAG 
(Figure 8). The camera will connect and automatically begin previewing the 
images at a high frame rate.

4. Gradually move the telescope focus inward until you get a sharp image on 
your computer screen. The SSPIAG focuses approximately 15mm inward 
from a standard 1.25” eyepiece.

5. You can use the Local RAW Preview, or 2D FFT screen to assist in focus-
ing.

Your frame rate will depend on your exposure time and computer processor 
speed. Fainter objects will require longer exposures whereas bright objects like 
Jupiter or the Moon will require very short exposures. Keep the Auto exp box 
checked unless you fine the image is too dim or too bright. If so, uncheck the 
Auto exp box and use the slider bar to manually adjust the exposure. The same 
adjustments can be made to Gain if needed.

capture
Once you have achieved focus, you are ready to capture and save images to 
your computer.

1. Select the number of Exposures you wish to save at the bottom of the 
screen.To keep it unlimited, leave the value at 0.

2. Assign a Name (the default name is “Series1”) and assign where the 
images will be saved in Dir..

3. Press Capture and the SSPIAG will begin capturing and saving images to 
your hard disk (Figure 11). If you set the Exposures to 0, then the camera 
will keep capturing until you click Stop.

Figure 10. Gradually move the focuser inward until you have a clear daytime image 
on your computer screen.

Figure 8. Connecting to the SSPIAG in PHD Planetary.

Figure 9. Previewing the live image after connecting.
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View and Stack
After you have captured your images, you can review them in PHD Planetary and 
discard the images you do not wish to include for stacking. PHD Planetary saves 
raw images in SER file format. This file format can also be used to export to other 
image editing programs like RegiStax.

1. In the File menu, select Stack images. Find the folder where you saved 
your captured images (Figure 12).

2. PHD will display the first image of your capture sequence (Figure 13). Press 
the <<<< / >>>> buttons to move through the individual frames. If you see 
an image you wish to discard (perhaps it is blurrier than the other images), 
click Disable and proceed to the next image. You do not necessarily have 
to page through each individual image before stacking, but it can help 
optimize your final stacked image.

3. Click Go and PHD Planetary will stack all of your images in to a single 
combined image. The status bar at the bottom left will indicate when the 
stacking is finished with a Stacking completed message.

Note: The number of images will add up quickly! Please ensure you have suf-
ficient hard disk space as the saved file size will increase very rapidly.

We recommend stacking a minimum of 50 images or more. The individual images 
have low bit depth (255 brightness level counts), and background noise. As such, 
you will not see much detail in the individual images. Stacking 100, 200, or more 
images is sometimes appropriate to get the most possible detail.

The planetary images should also look fairly dark. Check the Local RAW 
Histogram and Full Histogram and try to keep the histogram peak on the 
middle to left side of the window. Remember that stacking the images will bring 
out more detail, and actually add to the bit depth and brightness.

Subframing
Often times you will be imaging a very small object such as Mars or Saturn. You 
can crop the frame to a smaller area which speeds up the camera and saves 
hard disk space. This is referred to as subframing, or defining a region of interest 
(ROI).

Figure 11. Capturing images in PHD Planetary.

Figure 12. Located the SER file that was saved when you captured your images.

Figure 13. The stacking screen in PHD Planetary.
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Regions of Interest (ROIs or "subframes") can be very useful and PHD Planetary 
gives you full control over where these ROIs should be placed and how big they 
should be. An ROI is basically a crop of your image. You're telling the camera that 
you're only interested in a certain portion of the image, so only that portion will be 
downloaded from the camera and saved to disk. By using ROIs and cutting out 
portions of the image you don't care about (e.g., the large amount of black space 
around Jupiter) you speed up data collection significantly. This means that in the 
same amount of time you get many more frames of your target.

There are two ways to setup the subframe. First, you can select from a series of 
pre-defined image sizes from the View menu, 640 x 480, 400 x 400, or a 200 

x 200 subframe (Figure 14). These will cut your image size down by cropping 
the image (not resizing the image) down to a smaller size. This is useful if you're 
imaging a small target.

A second way to setup the subframe is to lay down two markers in opposite 
corners of the crop area you want. Right click (or Ctrl-left-click) on one corner of 
the region (Preview can be active or not) and you will see a red crosshair appear 
at that point (Figure 15). Then right click again on the opposite corner (it does 
not matter which corner or which order as long as the two are opposite corners). 
That's it! If you're already streaming the Preview, you will immediately see that 
you're now just streaming that portion of the frame. If you weren't, when you click 
the Start Preview button, you'll just get that portion.

Clearing the custom-defined ROI simply involves a shift-right-click (or shift-left-
click) anywhere in the image. This will take you back to the full-image view if you 
want a full-frame or if you want to define another ROI.

Processing
PHD Planetary saves all raw images in SER file format. This file format can be 
used to export to other image processing programs such as RegiStax. You can 
save an individual image in PHD Planetary in JPG file format if you have finished 
processing your image. PHD Planetary offers some basic processing features to 
touch up your images.

Adjust Color
In the Image menu, select Adjust Color. This will enable you to make adjust-
ments to Hue, Saturation, and Luminance strength (Figure 16).

Figure 14. You can choose preset subframe sizes in the View menu.

Figure 15. Right click on the image to set the desired subframe area.

Figure 16. The Adjust Color screen.
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Sharpen Image
In the Image menu, select Sharpen Image. In this screen you can utilize an 
unsharp mask (Figure 17) by adjusting the slider bars to the Radius and Amount 
of sharpening to apply.

Save
Once you have completed processing your image, go to the File menu and select 
Save current. PHD Planetary saves the current image in JPG file format.

Autoguiding
The SSPIAG with the use of PHD Guiding software makes the task of autoguid-
ing simple and easy to setup. The calibration and guiding is automatic once you 
initially find and focus a guide star. Your telescope must first be prepared for 
astro-imaging. Make sure your mount is polar aligned well. Your guide scope 
should be securely attached to your main imaging scope; or if you are using 
a Schmidt-Cassegrain, the off-axis guider and main camera should already be 
attached to the telescope.

Note: Autoguiding can correct for a mount that is poorly polar aligned. However 
the image will be harder to initially locate and center since it will still drift away 
from the camera’s field of view. Additionally, guiding with a poor polar alignment 
will eventually cause field rotation in a long exposure image. 

1. Locate, center and focus the celestial object you wish to image with your 
CCD or DSLR camera in your main imaging scope. Once you have centered 
the desired object, it is important to make sure the tracking on your mount 
is engaged so you don’t loose the object before the guiding starts.

2. Using a low power 1.25” eyepiece, locate and center a fairly bright star in 
your guide scope. Do not move the main imaging scope or your object will 
be lost! As stated in “System Requirements”, we recommend using adjust-
able guide scope tube rings to allow independent movement of the guide 
scope.

3. Remove the eyepiece and insert the SSPIAG into your guide scope.

4. Plug the SSPIAG into your computer’s USB port and connect the autogu-
ider cable from the SSPIAG to your mount’s autoguide port. Load PHD 
Guiding on your computer.

5. Click the Connect to Camera icon and select the Orion SSPIAG.

6. In the Exposure Selection pull down menu, select 2.0 s (Figure 18).

7. Click on the Looping Exposures icon to begin continuously taking pic-
tures.

8. Gradually move the focus inward on your guide scope until you see the 
star come into focus. As you get close to focused, the camera may start 
detecting several faint background stars.

9. Click on the star you want to guide on. A green guide star box should 
appear around the star you selected. In the lower left corner of PHD 
Guiding, the pixel coordinates of the star will be displayed. If the star is too 
bright, PHD Guiding will warn you with a meSSPIAGe at the bottom of the 
screen; if so you can choose a fainter guide star or reduce the exposure 
time.

Figure 17. The Unsharp Mask screen.

Figure 18. Select 2.0 s in PHD 
Guiding to set the exposure time to 2 
seconds.

Figure 19. Yellow crosshairs appear 
once the calibration begins.  The process 
is automatic.  The crosshairs turn green 
when guiding begins.
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10. Click the PHD Guide icon and the calibration will begin (Figure 19). The 
rest is automatic! Yellow crosshairs are displayed around the guide star 
box when the calibration starts. The calibration is automatic and takes 
a few minutes. When the calibration is complete, the autoguiding begins 
automatically and the crosshairs turn green. You are now ready to take 
astro-images with precise tracking!

Note: Be patient while PHD Guiding completes the calibration. The telescope 
cannot be disturbed during the calibration process. It is just as critical not to 
touch the telescope during calibration as it is when exposing an astro-image. 
The calibration ensures that the AutoGuider knows the movements and tracking 
behaviors of your mount.

Dark Frames and noise reduction
All CCD and CMOS cameras have inherent noise which becomes more apparent 
with longer exposure images. If you require taking longer exposures (typically 
longer than 3 seconds) you may start to see vertical lines and bright dots (hot 
pixels). There are several ways to reduce the amount of noise seen in your guid-
ing images. You will get the best guiding performance when your image back-
ground looks smooth and black. The Gamma Adjustment will help clip the low 
level background noise by adjusting the slider bar left or right as needed. You 
can also reduce the camera Gain or enable Noise Reduction (see “Advanced 
Autoguider Settings”). Take Dark saves a dark frame which is subtracted from 
your guiding images to remove most of the noise. Dark frames are images taken 
with the camera capped from incoming light, revealing only the camera noise in 
the image. This noise is subtracted from a “light frame” which is the image you 
want to see from the camera.

To take the dark frame:

1. Cap the objective of your guide scope.

2. Keep the Exposure Selection set to the same time you wish to use for 
guiding. For example, if you choose 2.0 s, then you must keep this expo-
sure time while guiding for the dark frame to be effective. 

3. Click Take Dark.

4. Remove the cap from your guide scope and resume taking pictures or 
guiding. PHD Guide will automatically subtract the dark frames from all of 
your exposures. To remove the dark frame, go to Tools and select Erase 
Dark Frame.

Advanced Autoguider Settings
The Advanced Parameters (the brain icon) in PHD Guide allows you to change 
several settings to better customize the guiding performance of your SSPIAG. 
Under normal use, you should not have to make any major adjustments to the 
Advanced Parameters. All of the calibration and autoguiding is done automati-
cally simply by pressing the PHD Guide icon.

 Advanced Parameters
R.A. Aggressiveness: Adjusts the percentage of R.A. correction per step. The 
default value is 100, meaning that the guider will move the full distance of the 
correction. If the seeing conditions are not steady, the aggressiveness can be 
turned down to smooth out the quick movements and reduce the correctional 
movement.

R.A. Hysteresis: Implements a percentage of the previous averaged tracking 
corrections to the current tracking corrections. This setting can be useful if you 
are experiencing some wind or severe periodic error, since the guider will partially 
ignore some of the radical movements and repeat a percentage of the previous 
tracking corrections.

Dec Guide Mode: This setting should not be changed under normal use. You 
can optionally disable dec guiding, or limit which direction the guider will allow 
dec to be corrected on (north or south). The default setting automatically finds 
which side dec is drifting (north or south).

Dec Algorithm: Ideally corrections made in declination should only be one con-
sistent direction, usually based on how well the mount is polar aligned. The Dec 
Algorithm takes this into account and attempts to keep the declination tracking 
consistent. Choose Resist switching or Lowpass filter which are algorithms that 
try to keep dec on one side of drift, or average the corrections made in dec.

Calibration Step: Adjusts how long each guide pulse is during calibration. The 
default is 500 milliseconds. The calibration step can be increased to provide a 
better sample of movement. However, if the calibration step is increased too 
much, the guide star will move out of the camera’s field of view during calibra-
tion.

Min. Motion: Number of pixels the star must move before PHD will make a guid-
ing correction. The default is 0.25 pixels.

Search Region: The area in pixels that the guide star is searched for and looked 
at. The default is 15x15 pixels. Under normal use, this setting should not be 
changed.

Noise Reduction: Choose from 2x2 mean or 3x3 median to smooth out noise 
and blur out hot pixels. 

Time Lapse: This setting optionally sets a delay between each guiding correc-
tion. For mounts that track exceptionally well, you can add a delay between each 
correction.

Gain: The gain adjusts the camera’s internal brightness level and sensitivity. The 
default is 95%. If you are experiencing excessive noise or hot pixels, you can 
reduce the gain. The camera remains very sensitive as low as 50% gain. If you 
are guiding on a very bright guide star, you can afford to turn down the gain and 
further decrease the noise in your image.
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Force Calibration: Enabling this setting makes PHD Guide calibrate every time 
a new star is chosen. If you move your telescope to another object in the sky, you 
will need to recalibrate the autoguider. The default has this setting enabled.

Log Info: You can log all actions into a text file saved in the PHD directory.

Disable Guide Output: This setting deliberately shuts off the autoguider output 
for potential troubleshooting measures.

Autoguiding tips & tricks
If all conditions are ideal, and your tracking is superb, you typically do not have to 
alter any of the camera’s default settings. However, if your setup is tracking much 
worse than usual (such as a night with high wind or poor seeing), you may need 
to customize your settings to better adapt to the current conditions in the field.

Reduce the R.A. Aggressiveness in the Advanced Parameters menu to bet-
ter stabilize the guiding during bad seeing or wind gusts. You may also want to 
decrease the R.A. Aggressiveness if your guiding exposures/corrections are 
set very quickly (less than 1 second). If the guider sends several corrections per 
second to the mount, the mount’s movement may osculate due to the response 
time of your mount. Additionally the varying seeing conditions makes the star 
appear to jump around rapidly and cause the guider to make unnecessary cor-
rections, sometimes referred to as “chasing the seeing”. If seeing is poor, keep 
the guiding correction intervals/exposures to 1 second or more. For most guide 
scopes, we recommend setting the autoguide exposures between 1-4 seconds 
for best results.

Polar Alignment
A good polar alignment of your EQ mount is of critical importance for long-expo-
sure imaging. Inaccurate polar alignment leads to field rotation, even with the 
autoguider tracking. If your equatorial mount uses a polar axis finder scope, we 
highly recommend utilizing it for polar alignment. If not, a technique known as the 
“drift method” of polar alignment has been used for many years, and can achieve 
an extremely accurate polar alignment. Unfortunately it is very time consuming, 
since the drift of a star over time must be observed. The basic idea is to let the 
telescope mount track while watching a star to see which way the star drifts. 
Note the direction of the drift, and correct by moving the mount in the appropriate 
direction.

To perform the drift method of polar alignment:

1. Roughly polar align your mount by pointing the R.A. axis of the mount at 
Polaris (the NorthStar).

2. Find a bright star near the meridian (the imaginary line running north-to-
south through zenith) and near the celestial equator (zero degrees declina-
tion). Point the telescope at this star, and center it in an illuminated reticle 
eyepiece (available from Orion). If you don’t have an illuminated reticle 
eyepiece, use your highest- magnification eyepiece.

3. Determine which way is north and south in the eyepiece by moving the 
telescope tube slightly north and south.

4. Now, let the mount’s motor drive run for about five minutes. The star will 
begin to drift north or south. Ignore any east-to-west movement.

5. If the star drifts north, the telescope mount is pointing too far west. If the 
star drifts south, the telescope mount is pointing too far east. Determine 
which way the star drifted and make the appropriate correction to the azi-
muth position of the mount. Rotate the entire mount (and tripod) slightly 
east or west as needed or use the azimuth adjustment knobs (if your mount 
has them) to make fine adjustments to the mount’s position.

6. Next, point the telescope at a bright star near the eastern horizon and near 
the celestial equator (Dec. = 0).

7. Let the telescope track for at least five minutes, and the star should begin 
to drift north or south.

8. If the star drifts south, the telescope mount is pointed too low. If the star 
drifts north the telescope mount is pointed too high. Observe the drift and 
make the appropriate correction to the mount’s altitude (or latitude); most 
mounts have some sort of fine adjustment for this.

Repeat the entire procedure until the star does not drift significantly north or 
south in the eyepiece after a few minutes. When this is accomplished, you are 
very accurately polar aligned. Autoguiding on a well polar aligned mount will yield 
the best results for your images. The fewer tracking corrections that have to be 
made, the better your images will be.

Differential tube Flexure
A common obstacle in guiding with a separate guide scope and imaging scope is 
differential tube flexure, the unwanted movement of a guide scope in relation to 
the main imaging scope. If any part between the autoguider and imager moves or 
flexes during the exposure, then the resulting image will have oblong stars which 
gives the appearance of poor tracking. There are a few basic measures to ensure 
your guide scope is securely in place:

1. If your guide scope has a focus lock, firmly tighten the focus lock thumb 
screw after you have focused on your guide star.

2. If you are using adjustable guide scope tube rings, make sure all thumb 
screws are firmly tightened against the guide scope tube.

3. The guide scope tube rings and mounting plate should be tightened very 
securely against the main imaging scope. Check for any visual flexure or 
movement by gently pressing against the guide scope.

4. The focuser and tube rings on the main imaging scope should also be 
firmly in place. It is not uncommon for screws and bolts to come loose after 
a few usages; so they should be checked before each imaging session.
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cabling
The SSPIAG uses only two light-weight cables; a USB cable and the autoguide 
cable. Keep an eye on the cables as you move the scope around. If there is any 
stress on the cables, your tracking will be affected.

Some imaging cameras use heavy-duty cables with significant weight. These 
cables can contribute to differential tube flexure. If you are getting images with 
oblong stars and your tracking appears to be good otherwise, try tying any heavy 
cables to a secure location on your mount. It does not take much resistance 
against the autoguider or imager to create poor tracking.

uSB Extension cable

In many instances, it is likely a longer cable for the SSPIAG will be needed in 
order to comfortably setup the telescope, camera, and computer. We recommend 
purchasing a 10’ USB extension cable if you need more cord length (available 
from Orion, item #5227).

using the SSPIAG with MaxIm 
Dl Essentials
For StarShoot Deep Space Imaging Camera users MaxIm DL Essentials version 
2.04 and later supports the use of the SSPIAG. You can simultaneously operate 
the StarShoot AutoGuider and StarShoot Deep Space Imager at the same time.

1. Plug the SSPIAG and the SSDSCI/SSDSMI (II) into the USB ports on your 
computer.

2. Load MaxIm DL Essentials. The Camera Control window should have 
an option to select Cam 1 or Cam 2 (Figure 20). You will also notice the 
Orion SSPIAG window appear in the center of the screen (Figure 21). This 
window allows you to adjust the camera gain and optionally enable noise 
reduction. 

3. Determine which camera the SSPIAG is, Cam 1 or Cam 2. This is done by 
taking a 1 second exposure in each camera. The camera that has the larger 
1280x1024 image is the SSPIAG.

4. Click the Autoguide tab in the camera control window. Select the camera 
that corresponds to the SSPIAG.

5. Click the Settings button.

6. Maxim DL Essentials needs to know how fast the telescope moves in right 
ascension (R.A.) and declination (Dec.) when the autoguider commands 
are issued. To do this, the software will Calibrate the mount by moving it 
back and forth on each axis. The Calibration Time determines how long 
it activates the motors each time. The default value is 10 seconds. Make 
sure all of the Guider Enabled boxes are checked (Figure 22).

7. For Autoguider Output, set Control Via to Camera.

8. Click Apply. You can leave this dialog box open, or Close it if you wish.

Figure 20. Cam 1 / 
Cam 2 camera control 
window in MaxIm DLE

Figure 21. MaxIm DLE 
AutoGuider window allows you 
to adjust the camera gain and 
optionally enable noise reduction to 
smooth out the background noise.

Figure 22. The autoguide Settings window 
controls the Calibration Time in each axis, 
movement in both axis, and the Autoguider Output 
connection to your mount.
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9. On the Guide tab, set to Expose, and click the Start button. A single 
image will be taken. Ensure that a well-focused bright star (near the actual 
object to be imaged) appears in the image. If not, adjust the guide scope 
and try again. Make sure the star is not close to the edge of the camera’s 
field of view or it may drift out during calibration.

Note: The algorithm can be confused if another star appears in the frame; to 
minimize this risk, calibrate on an isolated bright star. 

10. Now, set to Calibrate, and click the Start button. A series of five expo-
sures will be taken; each time the telescope will be moved slightly. If the 
telescope does not move, check the Settings.

11. The star should move in an “L” shape. If it does not move enough, a warn-
ing message will appear. The recorded positions will be displayed in the 
scrolling log, along with any error messages.

Note: If the star does not move far enough, or moves too far (i.e. the star leaves 
the field), the duration of the calibration move commands can be adjusted by 
clicking the Settings command and changing the Calibration Time fields 
(measured in seconds). A longer calibration time will increase the motion of the 
star; a shorter time will decrease the motion. Typical values range from five to ten 
seconds, depending on the correction speed, focal length, and pixel size. 

12. Once you have successfully calibrated, switch to the Track mode. Click 
Start, and watch the star. It should move to the center of the small track 
box, and whenever it drifts off it should be pulled back again. Also the 
tracking errors will be displayed in the scrolling log (Figure 23).

13. If the star bounces back and forth, reduce the aggressiveness for that 
axis. If it corrects too slowly, increase the aggressiveness. Changes to the 
aggressiveness settings take effect immediately.

care and Maintenance
When the SSPIAG is not in use, the cover cap should be replaced on the end 
of the nosepiece. This prevents dust from accumulating on the SSPIAG’s optical 
window. The optical window should only be cleaned if significant dust builds up 
for if the window is touched. Any quality optical lens cleaning tissue and optical 
lens cleaning fluid specifically designed for multi-coated optics can be used to 
clean the glass surface of the SSPIAG’s optical window. Never use regular glass 
cleaner or cleaning fluid designed for eyeglasses. Before cleaning with fluid and 
tissue, blow any loose particle off the surface with a blower bulb or compressed 
air. Then apply some cleaning fluid to a tissue, never directly on the optics. Wipe 
the optical surface gently in a circular motion, then remove any excess fluid with 
a fresh lens tissue. Use caution, rubbing too hard may cause scratches.

Specifications
Camera Sensor:  Color CMOS Aptina MT9V032

Sensor format:  1⁄3"

Pixel array:  752 x 480 (0.36Mp)

Pixel Size:  6.0µm x 6.0µm

Exposure Range:  0.001 sec to 5 sec (for PHD Planetary) 0.05 seconds  
    to 10 seconds (for PHD Guiding)

A/D Conversion:  8 bit

Thermoelectric cooling: No

IR filter:   Yes, removable

Mounting:  1.25" nose piece or t-thread

Weight (oz.):  4.4

Dimensions:  2.5" wide x 2.35" long

Mount connection: Via RJ-12 modular jack (6-pin)

Autoguide commands: “ST-4” output

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device nay not cause harmful interference, and 
(2) this device must accept any interference received, including interference that 
may cause undesired operation.

Changes of modifications not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 

Figure 23. Autoguiding in MaxIm DL displays the guide star in a small window with 
the Watch box enabled.  The tracking corrections are also displayed in the Camera 
Control window.
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are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio fre-
quency energy and, if not installed and used in accordance with the instructions, 
may cause harmful interference to radio communications. However, there is no 
guarantee that interference will no occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try 
to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an output on a circuit different from that to which the 
receiver in connected.

Consult the dealer or an experienced radio/TV technician for help.

A shielded cable must be used when connecting a peripheral to the serial ports.
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One-Year limited Warranty
This Orion StarShoot Planetary Imager & AutoGuider is warranted against 
defects in materials or workmanship for a period of one year from the date 
of purchase. This warranty is for the benefit of the original retail purchaser 
only. During this warranty period Orion Telescopes & Binoculars will repair 
or replace, at Orion’s option, any warranted instrument that proves to be 
defective, provided it is returned postage paid to: Orion Warranty Repair, 89 
Hangar Way, Watsonville, CA 95076. If the product is not registered, proof of 
purchase (such as a copy of the original invoice) is required.  This warranty 
does not apply if, in Orion’s judgment, the instrument has been abused, 
mishandled, or modified, nor does it apply to normal wear and tear. This 
warranty gives you specific legal rights, and you may also have other rights, 
which vary from state to state. For further warranty service information, 
contact: Customer Service Department, Orion Telescopes & Binoculars, 89 
Hangar Way, Watsonville, CA 95076; (800) 676-1343.
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